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Trademarks 

Microsoft is a U.S. registered trademark of Microsoft 

Corporation. 
Windows 7, Windows 8, Windows 10, and Windows 11 are either 

registered trademarks or trademarks of Microsoft Corporation in 
the United States and/or other countries. 

Other brands and product names herein are trademarks or 

registered trademarks of their respective holders. 

Copyright 

All rights reserved. No part of this publication may be 

reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, 

in any form or by any means, electronic, mechanical, magnetic, 
optical, chemical, manual, or otherwise, without the prior 

written permission of Avision Inc. 
 

Material scanned by this product may be protected by 
governmental laws and other regulations, such as copyright 

laws, the customer is solely responsible for complying with all 

such laws and regulations. 
 

Warranty 

The information contained in this document is subject to 

change without notice. 
 

Avision makes no warranty of any kind with regard to this 
material, including, but not limited to, the implied warranties 

of fitness for a particular purpose. 

 
Avision shall not be liable for errors contained herein or for 

incidental or consequential damages in connection with the 
furnishing, performance, or use of this material.  



 User’s Manual 

 iii 

 
 

FCC Radio Frequency Interference Statement  

This product has been tested and found to comply with the 
limits for a class B digital device, pursuant to Part 15 of the 

FCC rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 

interference, and (2) this device must accept any 
interference received, including interference that may 

cause undesired operation.   The FCC Class B limits are 
designed to provide reasonable protection against harmful 

interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy 

and, if not installed and used in accordance with the 

instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or 

television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 

correct the interference by one or more of the following 
measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and 

receiver. 

 Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected. 

 Consult your point of purchase or service representative 

for additional suggestions. 
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European Union Regulatory Notice 

Products bearing the CE marking comply with the following EU 
Directives: 

 Low Voltage Directive 2014/35/EC 

 EMC Directive 2014/30/EC 

 Restriction of the use of certain hazardous substances 

(RoHS) Directive 2011/65/EU 

 RED (Radio Equipment Directive) (2014/53/EC) 

 

This product satisfies the Class B limits of EN55032, EN55035, 

and safety requirements of EN62368-1. 

 

*This machine is certified as Class 1 LED product.  
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Disposal of Waste Equipment by Users in Private Union 

 

This symbol on the product or on its packaging indicates that 

the product can not be disposed of with your other household 
waste.  Instead it should be sent to appropriate facilities for 

recovery and recycling in an effort to protect human health and 
the environment.  Fore more information about where you can 

drop off your waste equipment for recycling, please contact 
your local city office, your household waste disposal service or 

the shop where you purchased the product.   
 

 
System Requirements 

 

CPU: Intel®  Core™ 2 Duo or higher 

Memory: 32 bit: 2 GB 
64 bit: 4 GB 

Optical Drive: DVD-ROM Drive 

USB Port: USB 2.0  

Compatible 

Operating 
System: 

Microsoft Windows 7, Windows 8 (32 bits/64 

bits), Windows 10 (32 bits/64 bits) 

 



User’s Manual 

 vi 

 

Product Safety Guide 

Please clearly read all these instructions, and follow all instructions 

and warnings before installing and using the device.  

The following indications are used in this document to obviate any 

chance of accident or damage to you and/or the device. 

 WARNING Indicates potentially hazardous situations, which 

if instructions are not followed, could result in 

death or serious injury. 

 CAUTION Indicates a potentially hazardous situation 

which, if instructions are not followed, may 

result in minor or moderate injury or damage to 

property. 

 

 WARNING 

 Use only the USB cable that came with your device and avoid 

abrasions, cuts, fraying, crimping, and kinking. Using any 

other USB cable could cause fire, electrical shock, or injury. 

 Place the device close enough to the computer so that the 

interface cable can easily reach between the device and the 

computer. 

 Do not place or store the device: 

 Outdoors 

 Near excessive dirt or dust, water, or heat sources 

 In locations subject to shocks, vibrations, high 

temperature or humidity, direct sunlight, strong light 

sources, or rapid changes in temperature or humidity 

 Do not use the device with wet hands. 

 Never disassemble, modify, or attempt to repair the device or 

device option by yourself, except as specifically explained in 

the device's documentation. This could cause fire, electrical 

shock, or injury. 
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 Unplug the device and the USB cable, and refer servicing to 

qualified service personnel under the following conditions: 

 Liquid has entered the device. 

 Object has entered the device. 

 The device has been dropped, or the case has been 

damaged. 

 The device does not operate normally (i.e. appearance of 

smoke, strange smell, odd noise, etc.), or exhibits a 

distinct change in performance.  

 Unplug the device and the USB cable before cleaning. 

 

 

 CAUTION: 

 Do not locate the device on rackety or aslope tables. Do not 

locate the device on unstable surface. The device may fall 

down and this may result in injury. 

 Do not place heavy objects on the unit. It may cause 

unbalance and the device may fall down. This may result in 

injury. 

 Store the AC Power cord/USB cable bundled out of the reach 

of children to avoid the risk of injury. 

 Keep plastic bags bundled out of the reach of children or 

throw them away to avoid the danger of suffocation. 

 If you are not going to use the device for a long period, 

unplug the USB cable from the electrical outlet. 
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FCC Caution: 

Any changes or modifications not expressly approved by the 

party responsible for compliance could void the user’s authority 
to operate this equipment. 

 
This device is intended only for OEM integrators under the 

following conditions: 
1)  The antenna must be installed such that 20 cm is 

maintained between the antenna and users. 
2)  The transmitter module may not be co-located with any 

other transmitter or antenna.  
 

IMPORTANT NOTICE: 

FCC Radiation Exposure Statement: 
This equipment complies with FCC radiation exposure limits set 

forth for an uncontrolled environment. This equipment should 
be installed and operated with minimum distance 20cm 

between the radiator & your body. To maintain compliance with 
FCC RF exposure compliance requirements, please avoid direct 

contact to the transmitting antenna during transmitting. 
 

IC Notice: 

Operation is subject to the following two conditions: 
1) This device may not cause interference and 

2) This device must accept any interference, including 
interference that may cause undesired operation of the device. 

 
IMPORTANT NOTE: 

IC Radiation Exposure Statement: 
This equipment complies with IC radiation exposure limits set 

forth for an uncontrolled environment. End users must follow 

the specific operating instructions for satisfying RF exposure 
compliance. This equipment should be installed and operated 

with minimum distance 20cm between the radiator & your body. 

This transmitter must not be co-located or operating in 

conjunction with any other antenna or transmitter. 
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Règlementd’ Industry Canada 

Les conditions de fonctionnement sont sujettes à deux 
conditions: 

(1) Ce périphérique ne doit pas causer d’interférence et. 
(2) Ce périphérique doit accepter toute interférence, y compris 

les interférences pouvant perturber le bon fonctionnement de 
ce périphérique. 
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Warning and Precautions of the lithium-ion battery 
 

Warning:  
Danger warning to prevent the possibility of the battery 
from leaking, heating, explosion, please observe the 
following precautions:    
 
 Don’t immerse the battery in water and seawater. 

Please put it in cool and dry environment if no using.  

 Do not discard or leave the battery near a heat source 
as fire or heater.  

 Being charged, using the battery charger specifically 
for that purpose.   

 Don’t reverse the positive and negative terminals.  

 Don’t connect the battery to an electrical outlet directly.  

 Don’t connect the positive and negative terminal 
directly with metal objects such as wire. Short 
terminals of battery is strictly prohibited, it may 
damage battery.  

 Do not transport and store the battery together with 
metal objects such as necklaces, hairpins.   

 Do not strike, throw or trample the battery.  

 Do not directly solder the battery and pierce the 
battery with a nail or other sharp object.  

 Do not use lithium ion battery and others different 
lithium polymer battery model in mixture.   

 Prohibition of use of damaged cells.   

 Don’t bend or fold sealing edge. Don’t open or deform 
folding edge. Don’t fillet the end of the folding edge.  

 Don’t fall, hit, bend battery body.  

 Battery pack designing and packing Prohibition injury 
batteries.  

 Never disassemble the cells.     
 Keep the battery away from babies.   
 Any components contacting these two edges, they 

must be insulated.  
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Caution:  
 

 Risk of explosion if battery is replaced by an incorrect 
type. Dispose the battery according to local regulations. 

 Never place batteries or devices on or in heating devices, 
such as microwave ovens, stoves, or radiators. Batteries 
may explode or leak flammable liquid when overheated 
or its performance will be degenerate and its service life 
will be decreased.  

 Do not use it in a location where is electrostatic and 
magnetic greatly, otherwise, the safety devices may be 
damaged, causing hidden trouble of safety.   

 If the battery leaks, and the electrolyte get into the eyes. 
Do not wipe eyes, instead, rinse the eyes with clean 
running water, and immediately seek medical attention. 
Otherwise, eyes injury can result.    

 If the battery gives off an odor, generates heat, 
becomes discolored or deformed, or in any way appear 
abnormal during use, recharging or storage, 
immediately remove it from the device or battery 
charge and stop using it.  

 Avoid charging batteries for more than a week, as 
overcharging may shorten battery life. Over time, 
unused batteries will discharge and must be recharged 
before use. 

 Disconnect chargers from power sources when not in 
use. 

 Use batteries only for their intended purposes. 

 Store the battery at 0°C to 40°C. 

 Highest specified charging temperature: 45± 3°C 
(113± 3°F); Lowest specified charging temperature: 
0± 2°C (32± 2°F). 

 Avoid exposing your device and batteries to very cold or 
very hot temperatures. Extreme temperatures can 
cause the deformation of the device and reduce the 
charging capacity and life of your device and batteries. 

  
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 Prevent batteries from contacting metal objects, as this 
can create a connection between the + and – terminals 
of your batteries and lead to temporary or permanent 
battery damage. 

 In case the battery terminals are dirt, clean the 
terminals with a dry cloth before use. Otherwise power 
failure or charge failure may occur due to the poor 
connection with the instrument.    

 Be aware discharged batteries may cause fire. Follow all 
local regulations when disposing of used batteries or 
devices. 

 Never crush or puncture the battery. Avoid exposing the 
battery to high external pressure, which can lead to an 
internal short circuit and overheating. 

 Exposure to extremely low air pressure may cause 
battery to explode or leak flammable liquid or gas. 
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1. Introduction 
 

 
Congratulations on your purchase of the color sheet-fed 

image scanner.  Avision is one of the leading companies to 
make high quality color image scanner.  

Before you install and operate the new scanner, please take 
a few minutes to read through this manual.  It provides 

proper instructions for you to unpack, install, operate and 
maintain the scanner. 

1.1 Package Contents 
 

The following figure indicates the package contents.  Please 

check all the items against your checklist.  If you do not 
receive all the items, please contact your authorized local 

dealer immediately. 

 

 

 

                      
 

1. Scanner Main Unit 

2. USB Cable 
3. Calibration Sheet 

4. Quick Guide 
 

  

   
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1.2 Top view 

 
 

 
 

 
 

Item Name Description 

1 
Feeder slot 

left edge  

Insert original into the feed slot, 
printed side UP and aligned with 

the left edge to begin scanning.   

2 Feed slot Feed your original to the slot. 

3 
Sliding 

paper guide  

Slide the guide up to the right 

edge of the original before 
inserting original into the feed slot 

to ensure proper alignment when 
scanning.  

4 Wi-Fi switch 
Turn on and off the Wi-Fi 

connection. 

 

3      

1   

2           

4     

 

4      
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1.3 Side view 

  

 

 

 

Item Name Description 

1 USB Type-C 
Used to plug the USB 

cable to connect to PC. 

 

 

1      
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1.4 Control Panel 

 
 

 

Item Name Description 

1 
Wi-Fi LED 

 

The LED light is solidly lit in blue color to 

indicate successful Wi-Fi connection in 
AP (Access Point) mode. 

2 

Battery 
LED 
 

 

Used to indicate the power status of the 
battery. 

Blinking red 

 

Low battery 

Red 

 

Charging in progress. 

Green 

 

Charging is finished. 

 

1 
 

2 
 

3 
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3 

Power/Scan  
button 

 

 

 Press to turn on the power. 
 Long press for 3 seconds to turn 

off the power. 
 Press to start a scan via PaperAir 

software. 

Blinking 

green 

 

The scanner is in 

power-saving mode.  

Press the Power 

button to wake from 
sleep. 

Green 

 

The scanner is ready 

to scan.  

Blinking 

red 

 

An error has 

occurred.  

Top cover is opened 

or the document is 
jammed. 
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2. Scanner Installation 
 

 

2.1 Precautions 

 

 Keep the scanner out of direct sunlight.  Direct exposure 
to the sun or excessive heat may cause damage to the 

unit. 

 Do not install the scanner in a humid or dusty place. 

 Place the scanner securely on an even, flat surface.  
Tilted or uneven surfaces may cause mechanical or 

paper-feeding problems. 

 Retain the scanner box and packing materials for 

shipping purposes. 
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2.2 Remove the Protective Tape 

Remove the protective tapes on the scanner and inside the 
document feeder as illustrated in below. 

 

 

       
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 



 User’s Manual 

 2-3 

 

 

2.3 Charging the Battery 

Please not the lion battery has already been installed into the 
scanner. For first-time use, please charge the battery for at 

least 4 hours. 
 

 

1. Turn off the scanner. 

2. Connect the USB connector of the USB cable to the USB 
Type-C port of the scanner. 

3. Connect the other USB connector of the USB cable to the 
USB port on your computer. 

 

 
 
 

Important: 

 Do not turn on the scanner power when charging the 

battery. 

 While charging the battery, the red battery LED light 

will be solidly on. After the charging is completed, the 
battery LED light will turn solidly in green. 

 When the battery is fully charged, an A4-sized of page 

can be scanned for 300 times at 300 dpi! 
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2.4 Turning on the Scanner 

Press the Power button to turn on the scanner. The Power LED 

will be first flashing and then solidly lit in green.  
 

 
 

2.5 Connecting to the Computer 

1. Connect the USB Type-C connector to the USB port of the 
scanner. 

2. Connect the other USB connector to the USB port on your 
computer. 

 
 

3. The computer should detect a new USB device and prompt 

a “New Hardware Found” message. 
4. When the Finish dialog is prompted, click the Finish 

button. 
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2.6 Installing the Software 

NOTE:  
The scanner driver contains TWAIN, and WIA driver.  After the 

installation of scanner driver is completed, this scanner allows 

you to scan via a TWAIN, or a WIA interface.  Start your 
TWAIN-compliant image editing software application to select a 

TWAIN or WIA user interface.  You may also launch Microsoft’s 

Scanner and Camera Wizard to scan via a WIA user interface.   

 
1. Download [Avision Update] at 

http://www.avision.com/install. 
 
2. Run [Avision Update.exe].  
 
3. The End User License Agreement screen will be prompted.  

Read the agreement and then choose [I Agree]. 

 
 

 
 

 
 

 

http://www.avision.com/install
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4. After your scanner has been recognized, click [Next] to 

continue. 

 

 
 

5. The available software applications will be prompted.  
Select the applications to install. Click [Install] and follow 

the on-screen instructions to complete the installation.  
 

 

*The list of available software applications varies according 
to your product type. 
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Contents on the installation graphic: 

 Driver:  To communicate with your scanner, you need 

to install the scanner driver.   

 PaperAir:  To use the buttons on the scanner, you 

need to install PaperAir.  

 AVScan X/PaperPort: To scan and organize your 

multi-page document(s), you can install the software 
application to manage them easily and effectively.   

 
Alternatively, 

 
You may also download driver and manual at 

www.avision.com/download. 

 
 

 



 User’s Manual 

 3-1 

3. Completing Your First 

Scan 
 

3.1     Suitable and unsuitable original types 

Suitable Original 

The scanner is designed to obtain the best scanning results 

with the following types of originals: 

 Photos and documents (3”x5”, 4”x6”, 5”x7”, 8.5”x14”) (76 

x 127mm, 102 x 152 mm, 127 x 177 mm, 216 x 356 mm)  

 Business cards [standard 3.5”x 2” (88 x 50 mm)or larger] 

 Long page (8.5”x 36”) (216 x 914 mm) for 300 dpi only 

 
 

Unsuitable Original Type 

Do not use the following types of originals for scanning, or the 

scanner may malfunction or cause the original to jam in the 
slot. 

 Originals thicker than 0.8 mm 

 Originals with either side shorter than 50 mm 

 Originals with lots of black or dark colors 

 Originals with dark colors surrounding the edges 

 Printed media (newspapers, magazines, etc.) 

 Soft and thin materials (thin paper, cloth, etc.) 

 Originals that are curled or wrinkled 

 Originals with staples or paper clips 
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3.2   Inserting Your Document 

IMPORTANT:  

 Insert only one page at a time, and insert the next one 
only when the previous one is done. Otherwise, the 

scanner may malfunction. 
 The paper detector is quite sensitive. Please do not push 

your document into the feeding slot or the top of your 

image will be cut. Simply let go the photo (card) when it 
begins to feed into the slot. 

 
1. Insert your document FACE UP to the feeder and align it 

to the left edge of the feeder.  
 

 
 

2. Gently push the original into the feed slot. 

3. Slide the guide lever against the right side of the original. 
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3.3    Verifying Your Scanner Installation   

To verify if your scanner installation is correct, Avision provides 
you a useful test program called Avision Capture Tool.  With 

this tool, you can perform simple scans and view the captured 
images.  In addition, it helps you complete your scan at a rated 

speed. 
 

The following procedure describes how to verify your scanner 

installation.  If the installation is not correct, please review the 
preceding section to check if the cable connection and scanner 

driver have been successfully installed.    

 

Before you begin, be sure the scanner is on. 

 
1. Select Start>Programs>Avision XXXX Scanner>Avision 

Capture Tool (XXXX: your scanner model). The Select 
Scanner Model dialog box will be displayed.  

 

2. Select your driver type and scanner model and click OK.  
The following Avision Capture Tool dialog box will be 

displayed. 
 

 

 
 

 

 

3. Choose your desired file format from the File Format drop 
down list box. (Default is BMP, other choice includes TIFF, 

MTIFF, PDF, MPDF, GIF, and JPEG.) The supported file 

formats vary depending on your scanner model. 

Setup      

Actual Size Fit Page 

Scan 
File Format 

Save       File Path 
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4. Type your desired folder name and file name in the File 
Path box. (Default is C:\My Scan\Image.) 

Note: If you do not wish to save the scanned image, 

deselect the Save button since default is Save Enable. In 
this case, the thumbnail view will be disabled.  And 

therefore, after viewing all the scanned images, only the 
last one will remain on the screen.   

5. Click the Setup button ( ) or choose Setup from the 
File menu to prompt the Scanner Properties dialog box. 

 

 
 
6. From the Image Selection Box, choose your desired image 

type for your scanned image.  (Default is Front B&W)  If 
you have a duplex scanner, choose Front and Rear to scan 

both sides of your document.  

7. Click OK to quit the Scanner Properties dialog box.  (To 
learn more details about the Scanner Properties dialog box, 

please see the subsequent chapter, Using the Scanner 
Properties Dialog Box.) 

Image 
Selection 

Box 
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8. Place your document face down on the document glass or 

face up in the auto document feeder. 

9. In the Scan Validation dialog box, click the Scan button 

( ) or choose Scan from the File menu. 

10. The document will be scanned and displayed in the Scan 
Validation screen.  After the scanned images have been 

displayed, your scanner installation verification is 
completed.  

 
 
 
 

11. You can view the scanned image in Fit Page ( ) or 

Actual Size (100%) button ( ) from the Viewing toolbars 

at the right side. 

12. Click the Close box or Quit from the File menu to exit the 

Scan Validation Tool. 

Fit Page View 
Thumbnail View 
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3.4    A Glance of the Scanner Properties Dialog Box  

 
 

1. Tab Options Choice:  Image, Compression, Color Dropout, 
Paper, Multi-Feed Detection, Preview, Options, 
Settings, Information. 

2. Image 
Selection Box    

Choose your image type and the side of 
document you wish to scan.  Options vary 
based on type of scanner.  

3. Brightness Adjust the brightness level from –100 to +100.   

4. Contrast Adjust the contrast level from –100 to +100. 

5. Resolution Determine the quality of the scanned image.  
The industry standard is 200 dpi. 

6. Invert Reverse the color of your scanned image. 

7. Scan Source  Choice: Auto Document Feeder, Flatbed, 
Flatbed (Book), Automatic (varies due to 
different scanner model)  

8. Defaults Reset all values on the tabs to the factory 
default settings. 

 
    

3 

4 
5 
6 

 
7 

1 

 

2 

8 
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4. Using the Scanner 
Properties Dialog Box  

 

 
The Scanner Properties dialog box allows you to configure the 

scanner’s settings. It consists of several tabbed windows each 
of which will be described in this chapter. 

 

NOTE:  

In this chapter, all options are available based on a duplex 
(double-side) scanner. If you have purchased a simplex 

(single-side) scanner, all options are available for single 
sided only. 

 

  
The Scanner Properties dialog box 
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4.1 Buttons on the Scanner Properties Dialog Box  

 
 

The buttons on the Scanner Properties dialog box 

 

Buttons Description 

Defaults Click the Defaults button, the factory default 

settings will be shown on each tab.   

Cancel Click the Cancel button to leave the Scanner 
Properties dialog box. 
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The following table shows the default settings： 

 

Tab name Default settings 

Image Image：Front B&W 

Binarization：Dynamic Threshold 

Resolution：200 dpi 

Invert：Blank on White 

Scan Source：Auto Document Feeder 

Threshold：None 

Brightness：None 

Contrast：None 

Compression None 

Color Dropout None 

Paper Cropping：Automatic 

Deskew：Yes 

Orientation：Portrait 

OverScan：0.00 

Note: The availability of this option 
varies due to scanner model.  

Unit：Inch 

Multi-Feed 
Detection 

None 

Preview None 

Options Rotation Degrees：None 

Blank Page Removal：None 

Edge Fill：White，0 mm 

Image Control Option：None 

Setting Enable Energy Saver：Enable, 15 
minutes after last scan action 

Show Scanning Progress：Yes 

Show Warning Message：Yes 

Save Settings after Closing：Yes 

Imprinter Digital Imprinter 
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4.2    Showing or Hiding Tabs 

 

The [Scanner Properties] dialog box is displayed in default 
with three basic tabs - Image, Paper, and Information.  To 

show more tabs, click the [Scanner Properties] icon to 
access more scan settings.  

 
To show more tabs, 

1. Click the [Scanner Properties] icon ( ) on the upper 
left corner, and choose [Tab] to show available tab 

names. The available tabs include Compression, Color 

Drop out, Preview, Rotation, Separation, Multi-Feed, 
Options, Settings, and Imprinter. (Note: the options vary 

based on scanner model.)  

2. Choose the tab you want to display. The selected tab will 

be shown with a check mark and then displayed in the 
[Scanner Properties] dialog box.  

3. To access the settings, click the selected tab on the top of 
the [Scanner Properties] dialog box. The page of the 

selected tab will be displayed. 

 
To hide a tab window, 

1. Click the [Scanner Properties] icon ( ) on the upper 
left corner, and choose [Tabs] to show available tab 

names. 

2. Choose the tab you want to hide. Then, the selected tab 

will be hided in the [Scanner Properties] dialog box.  

Note: The [Image], [Paper], and [Information] tab can 
not be hided since they preprogrammed to be displayed 

by default.  
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4.3  The Image Tab  

The Image tab allows you to choose the front side and (or) 

the rear side of your document, the type of image, and to set 
several basic scan settings.  Note that except for the 

resolution, you can set individual scan settings for the front 
side and the rear side.  For example, all settings in the Image 

tab, Compression tab, Color Dropout tab can be set 
individually for the front and the rear side.  However, the 

settings in the Paper tab, the Option tab, and the Setting tab 
have to be set the same for the front and rear side.   

 

 
 

The Image tab dialog box 
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4.3.1 The Image Selection Box 

 

The Image Selection box includes the 
image type and document side option.  If 

you wish to scan both the front side and 
the rear side of your color document, you 

can check both Front Color and Rear Color 

at the same time.  Note the options vary 
based on type of scanner. 

 
Example 1：Scanning a two-sided color document, both 

sides in color 

 

Side/Image 
Selection 

 
Front 

 
Rear 
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Example 2：Scanning a two-sided color document, one 

in B&W, the other in color 

 

Side/Image 

Selection 

 

Front 

 

Rear 

 

Image Type Description 

Color Choose Color if you wish to scan a color 
image for your original in color.  

Gray Choose Gray image if your original contains 

actual shades of gray. 

B&W Choose B&W if your original contains only 
text, pencil or ink sketch. 

 

  
 

B&W Gray Color 
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Front/Rear Auto Color Detection:  

Click to automatically detect and scan the front or the rear 

page of your color document in color image mode.  If your 
document is in colors, the scanner will automatically scan the 

document into a color image.  If your document is non-color, 

you can choose the output to be either B&W or Gray from the 
Non-Color Selection option.  This option is useful when you 

have a mixture of color and non-color document. 

Note:  If you choose Front Rear Auto Color Detection, you can 

not specify the image mode of your rear page and vice versas. 
 

Modes of Auto Color Detection: 

If [Front/Rear Auto Color Detection] is selected, its modes 

will be displayed. Choice includes Normal, Ignore Paper 

Color. For paper with background color such as invoices, 

choosing [Ignore Paper Color] will automatically remove the 

background color and enhance the detection accuracy. 

 

  

Normal Ignore single background 
color 
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Sensitivity of Auto Color Detection 

If your documents contain primarily B&W text and small 

amount of light or pale colors and you do not wish them to be 
recognized as color image to save the file size, you can 

increase the sensitivity value by moving the bar to the right to 
let these images to be detected as B&W. The value ranges 

from 1 to 100.  The default is 37. 
 

 
Original 
 

 

  
Sensitivity: 1  

(The image is recognized 
as a color one) 

Sensitivity: 100 

(The image is recognized 
as a black and white one) 
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Same settings on both sides: 

Click to apply same scan settings for both sides of your 

documents. After checking this option, any settings you have 
changed will automatically applied to both the front side and 

the rear side. For example, if you choose your ideal resolution 

to be 300 dpi, this will be applied both to the front side and 
rear side of your document. 
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4.3.2 Other Image Options 

 

Binarization This is the process of converting a 
grayscale or color image to a bi-tonal 

image. There are several different 
methods of performing this conversion.  

Options:  Dynamic Threshold, 
Dynamic Threshold (AD), Fixed 

Processing, Halftone 1~5, Error 
Diffusion. 

Dynamic Threshold:  Selecting 

Dynamic Threshold allows the scanner 
to dynamically evaluate each document 

to determine the optimal threshold value 
to produce the highest quality image.  

This is used to scan mixed document 
containing faint text, shaded background, 

or color background with a single setting.  
If Dynamic Threshold is selected, 

Threshold, Brightness, and Contrast are 

not available. 
 

Dynamic Threshold (AD):  Selecting 
Dynamic Threshold (AD) to perform 

the enhanced mode of the Dynamic 
Threshold feature. However, using this 

mode may slow down your scanning 
speed. 

 

Sensitivity of Dynamic Threshold 
Occasionally your scanned image may 

contain small dots or speckles. To remove 
these spots, increase the sensitivity value 

by moving the bar to the right. The value 
ranges from 1 to 30.  The default is 20. 
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 Fixed Processing:  Used for black-and-

white and other high contrast documents.  A 
single level is set to determine the black-

and-white transition. The threshold is 
programmable over the entire density 

range.  Fixed Processing sets Contrast to 
0.  If Fixed Processing is selected, 

Contrast is not available. 
 

Halftone:  In addition to the black and 
white display, Halftone can present a 

somehow gray shade of image by using 

different size of dots.  Halftone image looks 
like the picture we have seen in the 

newspaper.  Options include Halftone 1, 
Halftone 2, Halftone 3, Halftone 4, 

Halftone 5.  
 

Error Diffusion:  Error Diffusion is a type of 
Halftone.  Error Diffusion gives good image 

texture and makes text in images more 

readable than Halftone. 
 

 
Halftone Image 
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Error Diffusion Image 

 

 

 
 

Dynamic Threshold  Dynamic Threshold (AD)  
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Threshold Used to convert a grayscale image to a  

bi-tonal image. The value ranges from 0 to 
255. A low threshold value produces a lighter 

image, and can be used to subdue 
backgrounds and subtle, unneeded 

information. A high threshold value produces 
a darker image, and can be used to help pick 

up faint images.  
Adjust the threshold setting by dragging the 

Threshold sliding bar to the left or right to 
achieve the desired threshold setting. 

 

 
 

200 dpi, 
Threshold:50, 

Brightness: 0 

 
 
200 dpi,  

Threshold:100, 
Brightness: 0 
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Gray  

Document Type:  Choice:  Normal, Photo, Document   
Three options of document type are provided when you 

choose Gray as the image type for your scanned document.  
Choice:  Normal, Photo, Document.  

 Document: Choose Document if your original contains 
pure text or a mixture of text and graphic since it is an 

optimal setting for regular business document.  When 
using Document, only Threshold can be adjusted.   

 Photo: Choose Photo if your original contains photo to 
reproduce your photo in vivid grayscale image.  When 

using Photo, no Threshold and Contrast can be adjusted. 

 Normal: When using Normal, Threshold, Brightness, 
and Contrast can be adjusted.  

 
Threshold:  The value ranges from 0 to 255.  The default is 

230.  A low threshold value produces a lighter image, and can 
be used to subdue backgrounds and subtle, unneeded 

information. A high threshold value produces a darker image, 
and can be used to help pick up faint images. Adjust the 

threshold setting by dragging the Threshold sliding bar to the 

left or right to achieve the desired threshold setting. 
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Normal 

 
Photo 

 
Document 
(Threshold: 230) 

 

 
Normal 

 
Photo 

 
Document 

(Threshold: 230) 
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Brightness Adjusts the lightness or darkness of an 

image.  The higher the value, the brighter 

the image.  Drag the slider to the right or 
left to increase or decrease the brightness.  

The range is from –100 to +100. 
Contrast Adjusts the range between the darkest and 

the lightest shades in the image.  The 
higher the contrast, the bigger the different 

grayscale. Drag the slider to the right or 
left to increase or decrease the contrast.  

The range is from –100 to +100. 
 

  
 

Brightness: -50 Brightness: 0 

(Normal) 

Brightness: +50 

   
Contrast: -50 Contrast: 0 

(Normal) 

Contrast: +50 
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Resolution A good control of the resolution results a 

good detail of an image that scans.  The 
resolution is measured by dots per inch 

(dpi).  Normally, the greater the dpi number, 
the higher the resolution and the image file 

size.  Be aware that greater resolution takes 
more time to scan, and more disk space for 

the scanning image.  For your information, 
an A4 size color image scanned at 300 dpi at 

True Color mode consumes approximately 25 
MB of disk space. A higher resolution 

(usually means over 600 dpi) is only 

recommended when you need to scan a 
small area at True Color mode.  

Choose a resolution value from the drop 

down list. The default value is 200 dpi. 
Available resolutions are 75, 100, 150, 200, 

300, 400 and 600. Or you may choose your 
desired value by clicking the box in the right 

side of the drop down list and press the 

arrow key to select your desired value and 
then click the Add button to include it in the 

drop down list. Note:  The resolution is up to 
300 dpi if an imprinter or a MICR reader is 

installed or connected to the scanner. 

 
Resolution: 75 dpi 

 
Resolution: 150 dpi 
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Invert Reverses the brightness and the colors in the 

image.  The default setting is Black on a White 
background.  Reverse mode is White on a Black 

background. For color images, each pixel will be 
changed into its complementary color at the 

command of Invert. 
 

 
Black on White 

 

 

White on Black 
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Scan 

Source 

Choice: 

 Auto Document Feeder:  Used to scan 

multiple pages. 
 Flatbed:  Used to scan a single page. For 

example, pages from newspaper clipping, 
paper with wrinkles or curls.  

 Flatbed (book):  Used to scan several 
inside pages from book. 

 Automatic:  Allow the scanner automatically 
set its scan source.  If Automatic is selected 

and there is document in both the auto 
document feeder (ADF) and the flatbed, then 

the scan source will be automatically set to 

ADF.  If Automatic is selected and there is 
document only in flatbed, then the scan 

source will be set to flatbed. 
 Merge Two Sides into One Image:  

If you have a sheet-fed duplex scanner with 
front input tray, you can scan an A3 size 

document with an innovative method.  Thus, 
fold your A3 size document into A4, and then 

load the paper in the front tray.  Choose 

Merge Two Sides from the Scan Source 
option and then the scanner is able to scan 

both sides of your document and merge two 
A4 images into one A3 image.  

 
When you select Merge Two Sides into One 

Image, the Cropping or Multi-feed function 
will be disabled. 

 

Note: This feature must be used with a 
carrier sheet. Regarding how to load a 

document with a Carrier Sheet, refer to 
Section 4.6.2, Other Paper Selection.  

 
Note the options vary based on type of 

scanner. 
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NOTE:  

If you have purchased a duplex sheet-fed 
scanner, choose [Merge Two Sides] on the 

[Scan Source], then the scanner is able to 
scan both sides of your document and 

merge them into a single image. 

 

If “Merge Two Sides into One Image” is 

selected, its choice will be available including 
“Merge Horizontally”, “Merge Vertically”, 

“Merge Vertically (Back Side Flip)”.  If the 
reverse side of your document is upside down, 

choose “Merge Vertically (Back Side Flip)” and 
the back side will be automatically rotated 180 

degrees and merged. 

 
 

 
 

 
 

 
 

 

 
 

 
 

Note the options vary based on type of 
scanner. 

 
 

 

 

Front 
Side 

Rear 
Side 

Merge Vertically 

Front 

Side 

Rear 

Side 

Merge Horizontally 
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Color 

Matching 

 

The purpose of Color Matching is getting the 

accurate color. This option uses the default 

parameters (ICC profile) to adjust the colors 
of the image.  

Choice: None, Document, Photo 
 None: Choose “None” to disable this 

option. 
 Document: Choose “Document” if your 

original contains pure text or a mixture of 
text and graphic since it is an optimal 

setting for regular business document.     
 Photo: Choose “Photo” if your original 

contains photo to reproduce your photo in 

vivid color image.  
 

            
Normal 

 

 

 
After Color Matching 
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4.3.3 Scanning color images 

The following options are available for scanning color images.  

 Brightness 
 Contrast 

 Resolution 
 Invert 

 

4.3.4 Scanning grayscale images  

The following options are available for scanning gray images.  

 Brightness 
 Contrast 

 Resolution 

 Invert 
  

4.3.5 Scanning B&W images  

The following options are available for scanning B&W images.  

 Binarization (Dynamic Threshold) 

 Resolution 
 Invert 

 

Or 
 Binarization (Fix Processing) 

 Threshold 
 Brightness 

 Resolution 
 Invert 
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4.3.6 Editing Profiles 

 

The Scanner Properties dialog box allows you to change and 
save your frequently used scan settings into a profile.  You 

can edit these profiles by renaming or deleting them.  
 

To add a new profile, 
 

1. Customize your settings.  (For example, change your 
resolution, image type, cropping method, scan size, or 

other scan settings.)  
2. Click the Image tab and then choose “Profiles” to prompt 

the “Edit Your Profile” dialog box.  

 
 
3. Click “Add” to enter the name of the profile and then 

choose “Save”. 

 
 

4. The new profile will be saved and shown in the “Profiles” 
dropdown list box.  
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To load a profile,  

 

1. From the Image tab dialog box, choose your favorable 
profile from the “Profiles” dropdown list box. 

 

2. Your favorable profile will be immediately loaded and 

displayed on Scanner Properties dialog box. 
 

 
To delete a profile, 

 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Edit Your Profile dialog box. 

 
 

2. Choose the profile you want to delete from the dropdown 
list box. 

3. Click “Delete”.  A Confirm message “Are you sure you 
want to delete this profile?” is prompted. 

4. Choose “Yes” to delete or “Cancel” to quit. 
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To rename a profile, 

 

1. From the Image tab dialog box, click “Profiles” to prompt 
the Edit Your Profile dialog box. 

 
 

2. Choose the profile you want to rename from the 
dropdown list box and then click the Rename button. 

 
3. Enter new name for the profile. 

 
 
4. Choose “Save” to save the new profile or “Cancel” to quit. 

 

NOTE:  

 The preset default profiles include Flatbed, Simplex-
B&W, 200 dpi, Simplex-Gray, 200 dpi, Simplex-Color, 

200 dpi, Duplex-B&W, 200 dpi, Duplex-Gray, 200 dpi, 

Duplex-Color, 200 dpi.  If you have a simplex or a 
sheetfed scanner, the duplex or the flatbed option will 

not be available. 
 If any setting for a current profile has been changed, a 

[*] sign will be marked before the name of current 
profile, for example, [* Duplex, Color, 200 dpi]. If 

desire, click the [OK] or [Scan] button and a dialog 
box will be prompted to let you save the new profile. 
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4.4 The Compression Tab 

The Compression tab allows you to compress your scanned 

image and choose the level of compression.  Bi-tonal images 
are normally compressed using CCITT standard called Group 4 

(G4).  Color and grayscale images are often compressed using 

JPEG technology.  Move the JPEG Quality slider to the right 
or left to increase or decrease the level of compression.  Note 

the greater the compression level, the lower image quality.  
Default is 50%. 

 
Note that the compression depends on your image editing 

application.  If your image editing application does not support 
the type of compression format, then  either a warning 

message will appear or the image quality of the compressed 

file will not be acceptable.  
 

JPEG (Joint Photographic Editor Group).  This group developed 
and lent their name to a file compression standard for color 

and grayscale images that is widely used by scanners, and 
software applications.  On Microsoft Windows-based systems, 

a file with the extension .jpg has normally been compressed 
using this standard. 

 

For scanning color or gray images, the following compressions 
are available: 

 None 
 JPEG 

 
For scanning B&W images, the following compressions are 

available: 
 None  

 G4 
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Compression: 
To complete your scan at a rated speed, the scanned image is 

compressed by default during transmission.  However, if you 
wish to obtain the highest image quality, you can choose to 

uncompress the image data before it is outputted. 

 
 

 

 
 
 

To Application:  

Choose if you wish to compress the image data and transfer it 
from the TWAIN driver to the application. Note Bi-tonal 

images are normally compressed using CCITT standard called 
Group 4 (G4).  Color and grayscale images are often 

compressed using JPEG technology.  Move the [Image 
Quality] slider to the right or left to increase or decrease your 

image quality.  Note the greater the image quality, the lower 
the compression level.  Default is 50%.  

 
Note that the compression depends on your image editing 

application.  If your image editing application does not support 

the type of compression format, then the image of the 
compressed file will look abnormal. 

 
From Scanner: (Note: The availability of this feature 

varies due to scanner model.) 
Choose if you wish to compress the scanned image and 

transfer it from the scanner to the TWAIN driver.  
Choice: Uncompressed, *Best Image Quality (Low 

Compression Level), Better Image Quality (Normal 

Compression Level), Normal Image Quality (High Compression 
Level).  (*: Factory Default)   
 

 

 

 

 

Scanned 

Image 

Scanned 

Image 

Scanner Scanner Driver 
Image Editing 

Application 
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The Compression tab dialog box 
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4.5 The Color Dropout Tab   

4.5.1 Color Dropout Selection 

The [Color Dropout] tab allows you to select either green, 
red, blue, or a color of your choice to remove the details of 

the selected color from a scanned image. This feature is used 

to sharpen your text when using OCR (Optical Character 
Recognition) software. Note this feature applies only to the 

gray or black and white image.  

Choice: None, Auto, Remove Red, Remove Green, 

Remove Blue, Custom 

- None: Does not remove any color. 

- Auto: Automatically outputs the image with the details of 
the primary color removed.  

- Remove Red/Remove Green/Remove Blue: Outputs 

the image with the details of the specified color removed.  
- Custom: Specify the color you wish to remove by entering 

its RGB (Red, Green, and Blue) value respectively.  
 

Advanced Options:  
- Quality Mode: Range: 0~20. Default: 10  

When [Quality Mode] is selected, you can determine the 
color to be dropped out using the [Filter Threshold] slider. 

A lower value will drop more of the selected color out, 

while a higher value will leave more of the selected color in.    
- Normal Mode: Use an optimized setting to determine the 

color.  
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Original 

 

Auto/Remove Green 
(normal mode) 

 

Remove Red (normal mode) 

 

Remove Green (quality 

mode: Threshold: 18) 

 

Preview the color dropout result:   

To preview the color dropout result, please follow these steps: 

1. Click the [Scanner Properties] icon ( ) on the upper 

left corner, and choose [Tab] to show available tab 
names. 

2. Choose [Preview] to show the Preview tab. 

3. Click the [Preview] tab to show the Preview page. 

4. Load your document to the scanner and click the 

[Preview] button to get a preview image. 

5. On the [Image] tab, click [Gray] or [Black and White] 

image mode and then choose [Custom] on the [Color 
Dropout] tab. A [Preview window] button will be 

displayed. 

6. Click the [Preview window] button to prompt the 

[Preview] window with the previewed image. 
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7. Move your cursor over the preview image. Your 
mouse cursor now becomes an Eyedropper.  

8. Click to select a color which you wish to remove. 

9. Click and hold your mouse button to view the result 
after removing the specified color.  If the result is 

satisfactory, click [OK] to close the Preview window. 

      

The Preview Window        The Color dropout result 
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The Color Dropout dialog box 
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To select a color on the Color palette, 

 
 

1. Click the Color 
Dropout tab from 

the Scanner 
Properties dialog 

box. 

 

2. Choose Gray or 

B&W from the 
Image Selection 

box and click 
“Custom” from 

the Color Dropout 
drop-down menu. 

The Color palette 
appears. 
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3. Move your cursor 
over the palette. 

The cursor becomes 
a cross sign. 

 

4. Click to choose a color. The RGB values are changed 

simultaneously. 
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4.6   The Paper Tab  

The Paper tab allows you to define values relating to image 

output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-
Feed Detection).  

 

 

The Paper tab dialog box 
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4.6.1 Cropping  

Cropping allows you to capture a portion of the document 

being scanned.  Choice:  Automatic, Automatic (36”), 
Fixed to Transport, EOP (End of Page) Detection, 

Automatic Multiple, Relative to Documents. 

Options Description 

Automatic Automatic adjusts the cropping window 

according to different document sizes and 
automatically straighten a skewed 

document. Use this option for batches of 

mixed-sized documents. 

Automatic 
(36”) 

Automatically adjusts the cropping window 

according to different document sizes 
smaller than 36” and automatically 

straighten a skewed image. Use this option 
for batches of mixed-sized document.  

Note: The availability of this feature 

varies due to scanner model. 

Fixed to 

Transport 

This feature allows you to define the area 

or zone to be imaged.  Use for batches of 
same-sized documents.  If you select this 

option, you can use the arrow keys to 

define the x and y offset values, width and 
length to redefine your scanned area.  The 

Display window will show image placement 
as you change the values. 

EOP (End of 

Page) 

Detection 

This feature allows you to define the area 

or zone to be imaged.  Use for batches of 

same-width but different length 
documents.  If you select this option, you 

can use the arrow keys to define the x and 

y offset values, width and length to 
redefine your scanned area.  The Display 

window will show image placement as you 
change the values. 
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Automatic 

Multiple 

This option allows you to place various 

sized documents such as photos, ID Cards, 
or business cards on the flatbed (if 

available) and lets you create multiple 
individually cropped images in one scan. 

Note: To correctly create multiple images, 

please make sure there is at least 12mm 
(0.5”) of space between each document. 

Relative to 

Document 

This option allows you to crop different 

areas on your documents and deliver these 
images in B&W, Gray, or Color separately.  

For example, there are applications which 
require you to store the entire document in 

B&W and a part of the document in color to 
save storage space.  This is useful for 

documents where a photograph or 
signature appears in a consistent area on 

the document such as resumes, and so on. 

 

The following options are only available when Fixed to 

Transport is selected.  

 X-Offset — the distance from the left end of the 

scanner to the left edge of the scanning area.  

 Y-Offset — the position from the top end of the 

document to the top end of the scanning area.  

 Width — the width of the scanning area.  

 Length — the length of the scanning area.  

 Center: automatically calculates the x-offset for center-

fed feeding based upon document size selected. 

 — relocate the scan area by click the arrow key on 
the cross sign while retain the scan size.  View the result 

from the Display window.   
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The Adjustment option is available when Automatic is 

selected.  

 Adjustment —adds a positive/negative margin value 

Top/Bottom or toward left/right of the image. 

Adjustment is used when the automatic document feeder 

is used. Adjustment reduces the possibility of corner 
clipping on skewed images. To set Adjustment values, use 

the UP/Down buttons to select where you want to apply 

Adjustment values: Top/Bottom or Left/Right, and then 
select the amount of inches/mm/pixels applied. Select a 

value within the range of 0.00 to 1.00 / -1.00. 
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Relative to Document: (used for batches of same-sized 
documents) 

This option allows you to crop different areas on your 

documents and deliver these images in B&W, Gray, or Color 
separately.  For example, there are applications which require 

you to store the entire document in B&W and a part of the 
document in color to save storage space.  This is useful for 

documents where a photograph or signature appears in a 
consistent area on the document such as resumes, and so on.   

 
The following procedure describes how to reproduce the entire 

document in B&W and a portion of document (picture) in 

color.   
 

1. On the Paper tab, choose “Relative to Document” or 
“Fixed to Transport” from the Cropping option. 

2. Choose your scan size from the Scan Area option.  The 
selected scan size will be displayed in a red rectangular 

box.  This is also the scan size of your entire document. 
(For example, ISO B5.  If you have not chosen a scan 

area and leave the selection as None, then the default 

area will be the scanner’s maximum.)  

 

A red 
rectangular 
box 
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3. Click the Preview tab to display the Preview window.  A 

black rectangular box appears to indicate the max. scan 

size your have just selected. 

 
 

4. Click the Preview button to view the entire image in low 

resolution to correctly crop your relative scan area.  

 

5. Select image type from the Image Selection box.  The 

selected image will appear in highlighted color. (For 
example, Front Color) 

6. Place your cursor on the Preview window and click your 
left mouse button.  A cross sign will appear as illustrated.  

Create your relative scan size diagonally by dragging the 
left mouse button to your preferable size.  The selected 

area will appear in a red box as illustrated.  

A black 
rectangular 
box 

The Preview 
Image 

The Preview 
Button 

The Image 
Selection 

Box 
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7. Check the B&W image from the Image Selection box to 
scan the entire document. 

8. Click the Scan button to start scanning the document in 
two image types and sizes.  (See the result in below.)  

   
   The entire document in B&W     The relative area in color 

 

 

 
 

The 
Relative 
Area  

A Cross 
Sign 
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4.6.2 Other Paper Selection 

Carrier Sheet Mode: 

Check this option to automatically crop the scan window 
according to your document size when scanning non-standard 

document (fragile, irregular-size document) with a carrier 
sheet (optional). Note: The availability of this option varies 

due to scanner model. 
 

Loading Documents Using a Carrier Sheet 
 

A Carrier Sheet is a plastic sheet specifically used for loading 
non-standard document onto the scanner. It allows you to 

scan document that can not be scanned in the regular way. 

Also, documents larger than A4 size, such as A3 and B4, can 
be scanned by folding in half, inserting into the Carrier Sheet, 

and scanning in duplex mode. You can also scan documents 
that can be damaged quite easily such as photographs, or 

irregular size documents that are difficult to load directly such 
as clippings. 

 
To scan document using a Carrier Sheet,  

 

For documents larger than A4/Letter size, such as A3 

a. Fold the sheet to be scanned in half. 

b. Fold the sheet tightly and smooth out crease. Otherwise, 
the sheet may be skewed during scanning. 

 

1. Open the Carrier Sheet and place the document 
inside. 
Align the top of the document to the top of the Carrier 
Sheet (the printed area). 
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For documents larger than A4/letter size, such as 
A3 

Align the top of the document to the top of the Carrier 

Sheet (the printed section) and the folded portion to the 
right edge of the Carrier Sheet so that the document fits 

into the Carrier Sheet at the upper corner.  

 

For non-standard document 
Center your document in the Carrier Sheet. 

 
2. Load the Carrier Sheet with the gray section (printed 

section) facing downwards. 

 
3. Adjust the paper guides to the width of the Carrier 

Sheet. 
Adjust the paper guides so that there is no space 

between the guides and the Carrier sheet. Space 
between the guides and Carrier Sheet may cause the 

Carrier Sheet to become unaligned during scanning, and 
skew the scanned image. 

4.  Start the scan. 
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NOTE:  

 [Carrier Sheet] is available for the models that support 
the Carrier Sheet. 

 Some functions are disabled when [Carrier Sheet] is 
checked. 

 This option may not work properly on some applications. 
 

 

Scan Area  

Choose your desired paper size with the drop-down list box.  

Or you may select a custom paper size by clicking the Scan 
Area box and then click Add to include in the choice. 

Choices are listed below:  

None 

US Letter- 8.5”x 11” 

US Legal – 8.5” x 14” 

ISO A4 – 21 x 29.7 cm  

ISO A5 – 14.8 x 21 cm 

ISO A6 – 10.5 x 14.8cm 

ISO A7 – 7.4 x 10/5 cm 

ISO B5 – 17.6 x 25 cm 

ISO B6 – 12.5 x 17.6 cm 

ISO B7 – 8.8 x 12.5 cm 

JIS B5 – 18.2 x 25.7 cm 

JIS B6 – 12.8 x 18.2 cm 

JIS B7 – 9.1 x 12.8 cm 

Scanner Maximum 

Long Page (<118”) 

 
 
 
 

Long Page (<118”):   
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When you need to scan documents whose length exceeds 
scanner maximum, please choose Long Page.  Note if Long 

Page is selected, the Multi-Feed Detection will not be 

available. (Note: This option and the maximum allowable 
document length vary due to type of scanner.)   

 
When Long Page (<118”) is selected, be sure to specify 

your document size in the Length and Width field.  
 

Notice when scanning long page document: 

1. Pull out the extension in the ADF Paper Tray. 

2. Secure enough space around the Output Tray to 
prevent the ejected paper from falling off the Output 

Tray. 

3. To ensure the performance, in color mode, set the 

resolution to be 300 dpi or lower; in Black and White 
mode, set the resolution to be 600 dpi or lower. 

4. Depending on your system environments, application, 

or your specified paper size, there may be insufficient 
memory to perform scanning. 

OverScan 
Overscan allows you to add a specific margin at top and 

bottom or right and left (Options vary based on the type of 
scanner) of the edge of the image.  This is used to reduce 

possible corner clipping on the skewed images and often 
applied to a batch of skewed document to be scanned in the 

auto document feeder.  Select a value between 0 and +5 mm.   

Note the overscan result will not be shown in the Display 
window and that the availability of the function varies based 

on type of scanner.  
 

Pre-Feed 
Choice:  Enable, Disable.  If enable is selected, you can set 

the amount of time the scanner starts pre-feeding your paper 
after your documents has been loaded into the feeder. The 

default is disable. Note: The availability of this option varies 

due to scanner model. 
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Transport Timeout 

Set the amount of time the scanner will wait and then start 
auto scan after the first scan job is completed. If you have 

many separate documents need to be scanned at the same 
scan settings, this feature is especially useful. The default is 0.  

The value ranges from 0 to 30 seconds. 
 

NOTE: 

 Within the specified timeout period, if you load your 

document to the feeder, the scanner starts scanning 
automatically. 

 If your scanner has a flatbed option and you place your 
paper on the flatbed, after the timeout period, you 

need to click the Scan button on the TWAIN user 
interface to start scanning. 
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Background 

Setting 

This option allows you to set your scan 

background. Choice: White Background, 

Black Background. 

Note: For a sheet-fed scanner with an auto 

document feeder, this option is currently 
available only in the “Auto crop” mode. For a 

scanner with a flatbed platen, this option is 
available either in the “Auto crop” or the 

“Fixed to Transport” mode.  
 

 
White Background 

 

 
Black Background 
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4.7 The Multi-Feed Detection Tab 

Multi-Feed Detection    

Multi-Feed Detection allows you to detect overlapped 
document that go through the auto document feeder. Multi-

Feed usually occurs due to stapled documents, adhesives on 

documents, or electro-statically charged document. Note： 

The availability of the function varies based on type of scanner. 
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Additional Length Detection 

Additional Length Detection allows you to define the length of 
document being multi-fed.  This value indicates the additional 

length exceeding your scan area.  The Display window will 
show the size of the document as you change the value.  A 

value of 0 indicates no additional length detection.  The 
Additional Length Detection is best used when scanning same-

size documents in the auto document feeder.   
 

Ultrasonic Detection 
 

Ultrasonic Detection  allows you to set overlapped document 

by detecting paper thickness between documents.  Note： The 

availability of the function varies based on type of scanner. 

 

 
 Stop Scanning after Multi-Feed 

 
- If this is not selected, the scanner will continue scanning 

the rest document though multi-feed is detected. After the 
entire document has been scanned, a multi-feed dialog 

box will be prompted to indicate the page number which 
has been detected multi-feed and need to be rescanned. 

 
- If this is selected, the following options will be displayed. 

 
Stop: If this is selected, the scanner will stop scanning after a 

multi-feed is detected. No further dialog box will be prompted. 
 

Ask:  If this is selected, the image of the page which has been 
detected multi-feed will be displayed and three options are 

provided. 
 

 Continue Scan: If the image of the multi-feed 

page is acceptable, select 
[Continue Scan] to continue 

scanning the rest pages.   
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 Continue 
Scan(Discard 

Image): 
 

If the image of the multi-feed 
page is not acceptable, select 

[Continue Scan (Discard 
Image)] to scan the rest pages 

yet the multi-feed page will be 

ignored and you need to rescan 
the page again.  

 Stop Scan: 

 

The scanner stop scans. Remove 

the remaining pages in the 
scanner.  Remove staples or any 

adhesive tapes on your 
document. Or fan your document 

and rescan the rest pages.  

  

  
 Multi-Feed Alarm  

If a wave file is added, the scanner will make a sound 
alarm if multi-feed is detected yet no Warning dialog box 

will be displayed.   

 

How to add the sound alarm： 

1.  Click the Browse button on the right side of the speaker 
icon. The Open dialog box appears.  

2.  Choose your wave file.  

3.  Click the Open button.  The wave file is added.  

 

Units 

Defines the primary measurement system.  Inches, 

Millimeters, and Pixels are available.  
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4.8   The Preview Tab 

The Preview tab allows you to preview (a low-resolution scan) 

your image before final scan.  This preview image lets you 
allocate your scan area.  You can choose your scan area by 

the “Scan Area” drop down list box or placing your cursor on 

the Display window and dragging it diagonally on the Display 
window.  Then, a red rectangle box will appear to indicate the 

selected area. 
 

Note:  If you choose “Automatic Cropping” on the “Paper Tab”, 
then to select a scan area on the Preview tab is not allowed. 

 

 
 

The Preview Tab 

 

 
 

 

The Display 
Window 
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4.9   The Enhancement Tab 

The Enhancement tab allows you to set following additional 

image processing settings.   
 

 

The Option tab dialog box 
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Punch 

Hole 
Removal 

You can remove punch holes from the output 

scanned image when scanning punched document. 
Note the availability of this feature varies 

depending on your scanner model. 
 

 
 

 
 

 
 

 

 
 

 
 

Punch holes can not be removed when: 
 Resolution is set lower than 150dpi 

 The hole is near the edge of the document 
 The holes are not aligned along the edge of the 

document 

 Punch Hole Removal is available only when 
“Auto Crop” is enabled. If either “Fixed to 

Transport”, “EOP (End of Page) Detection”, 
“Automatic Multiple”, “Relative to Documents” is 

selected from the Cropping option on the Paper 
tab, the Punch Hole Removal option will be 

disabled. 
 

 

Original Output image 
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Shadow Removal When 「Flatbed」on the 「Scan 

Source」 option is selected on the 

「Image」tab, the 「Shadow 

Removal」option will be enabled. Click 

to remove the shadow on the book spine 

when scanning a book.  
 

 
 

  

Before Shadow 
Removal 

After Shadow Removal 
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Background Processing:  The [Background Processing] 

option allows you to smooth background color or remove it to 
make image clearer. The option is especially useful for 

documents with color forms such as invoices.  
Choices: None (default), Smooth, Removal  

- None - no background processing will be performed 
(default) 

- Smooth - produces images with a more uniform 
background color. This option improves image quality. 

- Removal - identifies the background color and then 
removes it.   

 

Sensitivity:  Choice: 0, 1, 2, 3, 4.  Default: 0  
- The higher the value, the more background color will be 

kept.   
 

Mode: Auto, Moiré   
If [Smooth] is selected in the [Background Processing] 

option, then the choices for the [Mode] option includes Auto, 
and Moiré.  

- Auto - uses the factory preprogrammed mode to proceed 

background smoothing.  
- Moiré  – Remove the moiré patterns that appear on the 

background of the image when scanning printed material. 
 

If [Removal] is selected in the [Background Processing] 
option, then the [Mode] option will be replaced with [Fill 

Color]. Choices: White, Auto.   
- White - identifies the background color and substitutes it 

with white. 

- Auto - identifies the background color and substitutes it 
with the color of the largest background zone.   
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Background Processing: None 

 
 

      
 

Background Processing: 

Smooth 

Background Processing: 

Removal 
 Fill Color: White 

 
         

NOTE:  

Background color in small zone will not be processed or 

removed. 
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Edge 

Fill 

Check White or Black if you wish to add white or 

black edge on the border of your scanned image. 
Enter the value from 0 to 5 mm.  Default value is 0. 

 
Original 

 
Edge Fill: 5mm (Black) 

 

If you want to add a white or black frame on the 

edges of the scanned image, check "Edge 
Extension". 

 
The default value is 0. The maximum value is half of 

the short side of the selected scan area. 
For example, if you choose an A4 size (8.26 

"X11.69"), then the maximum value of the white or 
black box is 4.14" (half of "8.26"). 
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Despeckle 

 

Occasionally small dots or specks appear in the background of 
a scanned image. Remove unwanted speckles provides a 

cleaner image for OCR (Optical Character Recognition) 
processing, and also helps to reduce compressed file size. 

 
Define the speckles (also known as image noise) you wish to 

remove by specifying its number (size) and radius (range). 
The measuring unit is pixel. The higher the number, the more 

speckles will be removed.  
 

 
Before Despeckle  
(noise number:0, noise radius:1) 

 
 

 
After Despeckle  

(noise number:22, noise radius:10) 
 

NOTE:  

 The function is currently available for Black and White 

image only. 
 To scan at rated speed, it is recommended to set the 

noise radius up to 10 pixels. 
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Line Removal: When Black and White image mode is 

selected on the [Image] tab, the [Line Removal] option will 

be enabled. Line Removal erases lines on the image and then 
reconstructs characters so the OCR (Optical Character 

Recognition) accuracy can be improved. 

Choices: None, Form, Horizontal, Vertical 

None – the default mode which does not remove any line. 

Form – remove any form in the document. 

Horizontal – select [Horizontal] and then enter the length 
of horizontal line to remove only the horizontal line exceeding 

your specified length. 

Vertical – select [Vertical] and then enter the length of 

vertical line to remove only the vertical line exceeding your 

specified length. 
 

  

None  Remove Form 

  

Remove Horizontal Line 

(over 30 mm) 

Remove Vertical Line 

(over 70 mm) 
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4.10 The Rotation Tab 

 

The Rotation tab allows you to set the following image rotating 
options:  
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Rotate 

Image 

Choose the rotation angle from the drop down 

list if you wish to rotate your scanned image. 

Choice: None, 90°CW(clockwise), 
90°CCW(counter clockwise), 180°, Auto 

based on contents. Auto rotate every 
even page. 

 

Original  
Rotate 90°CW 

 
Rotate 90°CCW 

 

Rotate 180° 

 

 Auto based on contents:  Automatically 
rotate images based on the contents of 

document. When「Auto based on 

contents」 is selected, its modes will be 

enabled to let you select more options. 

Mode: Quick, Full Text, Complexity 

Quick – the default mode to let you rotate 

images at the fastest speed. 

Full Text – the enhanced mode for 

documents with mixed text orientation. 

Complexity – the enhanced mode yet at the 

slowest speed for document with complex 

image or text orientation. 
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Auto rotate every even page: 

Automatically rotate 180° on every even 

page.  This is especially useful when you scan 
the inside pages from a book.  As a result, if 

you choose “Flatbed (book)” from the “Scan 
Source” option, “auto rotate every even page” 

will be selected as default.   
 

Note:  This option varies based on type of 
scanner. 

 

  
Document with various 
text orientations 

Document with dark or 
complex background 
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Split 

Image 

By splitting an image, two separate images are 

created horizontally or vertically. This is useful 
for documents containing two pages per image 

when you want to save them as two images 
(one page for one image). Choice: None, 

Horizontal, Vertical. Default is None. 

Horizontal: Divide one image into the upper 

half and the lower half.  

Vertical: Divide one image into the left half and 
the right half. 

 
 

Split Horizontally 

 
 

Split Vertical 
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Flip Side 

Rotation 

Select “fanfold” to rotate the image of the 

reverse side to 180 degrees.   

This is applied to double-sided document 

which are viewed in portrait are sometime 
fed into the scanner in landscape or vice 

versa.   

Choice: Book, Fanfold. 

If “Book” is selected, the image of the 

reverse side will not be rotated.  

 

The following illustration shows the documents which should 
be viewed in portrait are fed into the scanner in landscape 
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Image 

Control 
Option 

Check the Mirror box if you wish to reverse the right 

and left side of your image. 

 

 
Original 

 

 

 
The Mirror Effect 
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4.11 The Separation Tab 

The Separation tab allows you to enable the detection engine 

to detect the blank page, barcode, and patch code and then 

notify the software application which supports document 

separation to separate your multi-page documents. Choices: 

Blank Page Removal, Barcode Detection, Patch Code Detection. 

 
 

Blank Page 

Removal 

Choices: None, Blank Page Removal Threshold, 

Image Size. 

None – Do not remove the blank pages.  
Threshold - Move the slider to the left or right 

to define your threshold for the blank page. 
Image Size – Range: 1~ 10000 KB. Specify 

your desired image size to detect the page as a 
blank page. For example, if 3 KB is selected, 

any page less than 3 KB will be recognized as 
blank page.   
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Barcode 

Detection 

Check [Enable] to detect barcode and notify 

the software application for advanced 

processing. Please note the whole document 
will be checked and no specific detection area 

needs to be designated. 

When the bar code has been detected successfully，a file 

[avbarcode.ini] will be created and stored in the following 

path:  
 

Windows XP:  C:\Documents and Settings\All 
Users\Application Data\%PRODUCTNAME% 

 
Vista, Windows 7, Windows 8, Windows 10: 

C:\ProgramData\%PRODUCTNAME% 

Barcode Types: 
The following barcode types can be detected.  

 
Two-dimensional codes 

 Aztec 
 DataMatrix 

 PDF417 
 QR Code 

 

One-dimensional barcodes: 

 Add-2 

 Add-5 

 Australian Post 4-State   

 BCD Matrix  

 Codabar  

 Code 128   

 Code 32  

 Code 39  

 Code 93  

 DataLogic 2 of 5  

 EAN 128 

ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Aztec.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/DataMatrix.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Australian%20Post%204-State%20Barcode.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/BCD%20Matrix.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Codabar.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Code%2032.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Code%2039.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Code%2093.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/DataLogic%202%20of%205.html


User’s Manual 

 4-70 

 

 

 EAN-13 

 EAN-8    

 GS1 DataBar  

 Industrial 2 of 5 

 Intelligent Mail   

 Interleaved 2 of 5  

 Inverted 2 of 5  

 IATA 2 of 5 

 Matrix 2 of 5  

 PostNet  

 Royal Post  4-State   

 UPC-A 

 UPC-E  

  
NOTE:  

 Recommended resolution: 200~600 dpi for regular 

barcode, 300~600 dpi for QR code.  
 Skewed barcodes may not be recognized correctly. 

 Using the same sheet repeatedly may decrease the 
recognition accuracy due to accumulated dirt on the 

sheets. If the sheet is not recognized correctly or gets 
smudged, replace it with a new sheet. 

 

Barcode Zone: 
Specify the barcode zone to be detected.   

Select 「All」 to checks the whole document and detects 

barcodes. Or you may speed up the process by specifying a 
detection area since only the specified area is checked. 

Choice: All, Top, Bottom, Left, Right, Bottom Right, 
Bottom Left, Top Right, Top Left  

ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/EAN-8.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/EAN-8.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/EAN-8.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/GS1%20DataBar.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Industry%202%20of%205%20(Industrial%202%20of%205).html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Intelligent%20Mail.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Interleaved%202%20of%205.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Inverted%202%20of%205.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Matrix%202%20of%205.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/PostNet.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/Royal%20Post%204-State%20Barcode.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/UPC-A.html
ms-its:D:/f/Document%20New%20UI/AutoSoft%20barcode/Accusoft.BarcodeXpress10.ActiveX.chm::/UPC-E.html
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Choice for barcode zone on a page: 

 

 
 

 

 

 
 

 

 

All 

 

 
 

 

 

 
 

 

 

Top 

 

 
 

 

 

 
 

 

 

Bottom 

 

 
 

 

 

 
 

 

 

Left 

 

 
 

 

 

 
 

 

 

Right 

 

 

 
 

 

 

 
 

 

Bottom 

Right  

 

 

 
 

 

 

 
 

 

Bottom 

Left 

 

 

 
 

 

 

 
 

 

Top Right 

 

 

 

 
 

 

 

 
 

 

Top Left 

 

 

 
 

Patch code Detection: 
Check [Enable] to detect patch codes and notify the software 

application for advanced processing. 

A patch code is a pattern of parallel, alternating black bars 
and spaces (i.e. a barcode) that is printed on a document. 

Patch code sheet is most commonly used as a document 
separator in a stack of document.  
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You can find various sizes of patch codes (PDF) by choosing   

[Start] menu>[All Programs]>[Avision Scanner 

Series]>[Patch code] in succession.  

Simply print the PDF file to produce the patch code sheet. 

Insert the patch code sheets to wherever you want the file to 
separate. 

 
 

NOTE:  

 Use blank white paper.  
 Set the scaling to 100%. The sheet is not recognized 

correctly when printed in a size smaller than the 
original. 

 Do not use toner saving mode. The sheet is not 
recognized correctly when the print is too light. 

 Do not use thin paper in order to avoid bleed-through 

from the back. 
 When you copy a patch code sheet that you printed 

out, make sure to copy by the same size and 
brightness as the original copy. 

 Use the same sheet repeatedly may decrease the 
recognition accuracy due to accumulated dirt on the 

sheets. If the sheet is not recognized correctly or gets 
smudged, replace it with a new sheet. 

Patch code sheet 
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4.12 The Setting Tab  

The Setting tab allows you to set the following settings: 

 

The Setting tab dialog box 

 

Energy Saving 
Control 

Check the Enable Energy Saver box 
and move the slider to set the amount 

of time to start the energy saver after 
your last action. The range is from 1 to 

60 minutes.   

Enable Power 
Off   

Check the Enable Power Off box and 
move the slider to set the amount of 

time to automatically turn off the 

scanner after your last action. The 
range is from 1 to 480 minutes.  The 

default is 240 minutes (4 hours). Note 
the value of “Power Off” has to be 

greater than or equal to the value of 
“Energy Saving”. 
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Cache 

 

Mode: None, Page Number, Memory 

Size.  
This option allows you to assign a specified 

memory size from the available RAM to 
process the image data. By specifying a 

smaller memory size, you can free more 

memory for other applications you are 
running. By specifying a larger memory 

size, you can have more memory to 
process the image data especially when you 

have a large amount of documents needed 
to be scanned.  

 
You can also specify your memory size by 

the page number. For your information, an 

A4 color document scanning at 300 dpi 
consumes approximates 24MB. 

Image Count 
When the selected cache mode is “none”, 

the image count option allows you to assign 
number of pages you need to scan. For 

example, if you wish to scan the first two 
pages, simply move the page slider to 2, 

and the scan action will be stopped when 

the scanning of the first two pages have 
been completed. 
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Show Scanning 

Progress 

Check and the scanning progress bar 

will be shown during scanning. 

Show Warning 

Message 

Check to show the warning messages 

such as “ADF pad count exceeds 
50,000 scans (the number varies based 

on type of scanner). Please replace the 
ADF pad and reset the pad count.” 

Save Settings 
after Closing 

Check to save your scanner properties 
settings after leaving the dialog box.  

Next time when you open the Scanner 
Properties dialog box, the previously 

saved settings will be shown. 
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4.13 The Imprinter Tab 

The Imprinter tab allows you to print alphanumeric characters, 

date, time, document count and custom message on your 
scanned image if digital imprinter is selected or at the back of 

your document if external imprinter is selected.  

 

 
 

 
Choice:  External Imprinter, Digital Imprinter. If you 

have installed an external imprinter, choose external 
imprinter. If you do not have an imprinter, choose digital 

imprinter. Note External Imprinter provides a vertical and 
rear-side print capability while digital printer provides a 

horizontal and front-side print capability. 
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Contents 

Print All Check Print All to automatically print the 
text at all pages of your documents.  

Uncheck Print All to print the text for the 
first page of your documents only. 

Custom Enter your custom text to be included in your 

print string.  

Counter Show the document count for the scan 
session. This value is increased sequentially 

by the scanner.    

 

Date/Time Choose if you wish to include the date and 
time in your print string. 

Format: YYYYMMDDHHSS For example, 
20090402170645-check0001 indicates year, 

month, date, hour, seconds, your custom 
text and the counter. 

Custom 

Font 

Choose your desired font.  

Choice: Normal, Fixed Width 
Fixed Width (Mono spaced) fonts have a 

fixed character spacing. So each character 

occupies the same width. 

 

Advanced 

Font 
Attributes 

Choose your font attributes.  Choice:  
Normal, Underline, Double, and Bold. 
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String 

Orientation 

Choose your string orientation. 

Choice: Normal, Rotated, Vertical, 
Vertical Inversion, 90 degrees CW, 90 

degrees CCW 

 
Normal 

 
Rotated 

 
Vertical 

 
Vertical Inversion 

 
90 degrees CW  

90 degrees CCW 
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Print 
Position 

Choose the position you wish to print your 
string. Move the slider to the right to increase 

the value or to the left to decrease the value. 
Range: 0~355mm, default:0 mm 

The value indicates the height from the 
bottom of your paper to the last letter of your 

string. This option is available only if an 

external imprinter is installed. 
 

 
 

 
 

 
 

 

 
 

 

Print Position (for digital imprinter) 
Choose the position of your printed string. Choice: Top, 

Middle, Bottom, Custom. If Custom is selected, enter the X 
and Y offset value to specify the position. 

More:  Click the [More] button to display more font options. 
This option is available for digital imprinter (stamp text on 

your scanned image) only. This function is not available on 
some models.  

Font size: Move the slider to change the font size from 1 to 

10. Density: Move the slider to change the source density 
from 0 to 255. The selected density will appear at the same 

time. 

Transparency: Move the slider to choose an appropriate 

transparency value from 0% (not transparent) to 100% 
(completely transparent) so that your text can be partially 

transparent and you can see the background image. 

The value of 
Print Position 

0
0
0
z
1
a
b
c
 2

0
1
0
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4.14 The Information Tab  

The Information tab displays the following system and scanner 

information.  

 
 

The Information tab dialog box 
 

The “Report” button： 

If you encounter any error message while using the scanner, 
click the Report button.  A report.txt file [Windows XP:  

C:\Documents and Settings\All Users\Application 
Data\%PRODUCTNAME%; Vista, Windows 7, Windows 8, 

Windows 10: C:\ProgramData\%PRODUCTNAME% (C: system 
drive)] will be generated.  Please send this file to the nearest 

service center for trouble shooting.   

 
 

xxx 
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5. Using the Buttons  

 

 

5.1 Installing PaperAir 

 
Download PaperAir software application on our website at 

http://avision.com/download 
 

The PaperAir application provides you an easy way to scan your 
document and then link the scanned image to your designated 

software application.  All this can be done by a simple touch of 

the button on the scanner. Yet, before you scan, it is 
recommended to check the button configurations first to ensure 

a proper file format and a destination application.   

 

 
 

 



User’s Manual 

 5-2 

 

5.2 Checking the Button Configurations before Scanning 

 

1. Make sure that the scanner driver has been installed on 

your computer, the scanner has been connected to your 
computer, and the scanner has been turned on. 

 
2. After the PaperAir software application has been properly 

installed, the PaperAir will be automatically started.  The 
main window of PaperAir will be displayed and the PaperAir 

icon will be displayed both on the Start menu and the 
toolbar as shown in below.  

 

 

The main window of PaperAir 
 

    
 

PaperAir icon will be displayed at the Start menu and the 

toolbar.  
 
 
2. Right-click the [Quick Scan] button. A default [Scan 

Setting] dialog box will be displayed. 

 

 

 



 User’s Manual 

 5-3 

 
 

 

 
 
 

If you wish to change the setting, use this window to reset 
the setting for the file format, destination application, or 

other scan settings.     

 
3. Click the OK button to leave the window.  
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5.3 Scanning From One Touch of the Buttons 

 

1. Load paper into the feeder.   

2. Click the Quick Scan button on the main window of 

PaperAir. 

Or press the Power button on the scanner. 

3. In a second, a thumbnail image of your document will be 
displayed. 
 

 
 

 

 
Note: 

For more detailed information on how to use PaperAir, 

please refer to the user’s manual. You may download the 
user’s manual on our web site at 

www.avision.com/download. 
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6. Starting a Scan from 

Your Mobile Device 
 

 

With a built-in Wi-Fi module, the scanner can be converted into 

a wireless device.  When a mobile device is use, the scanned 
images can be received from the mobile device. 

6.1 Making Preparation 

 PaperAir Application 

Download the PaperAir Application on your mobile device 
from an application store such as Google Play. 

 

 

 

 

 

 

 

 

6.2 Connecting to a wireless network  

In AP (Access Point) mode, your mobile devices and the 
scanner are connected wirelessly without an additional AP 

(Access Point) since the scanner itself works as an AP. 

 
 

 

PaperAir 
App 

 

- AP (Access Point) 



User’s Manual 

 6-2 

 

1. To turn on the Wi-Fi connection, slide the Wi-Fi switch to 
the [On] position. If the connection is successful, the Wi-Fi 
LED light will be lit solidly in blue. 

 

   
 

2. On your mobile devices, make sure Avision–xxxx (xxxx 

indicates the last four digits of the Mac Address at the 
back of the scanner) has been selected as your network 

name (SSID). 
 

6.3 Scanning a document from a mobile device 

Make sure that the PaperAir Application (Scan App) has been 
installed on your mobile device. The PaperAir Application can 

be purchased for free from an application store such as Google 
Play. 

1. Enable [Wi-Fi] from [Settings] of your wireless computer, 
smartphone, or tablet and then choose the same network 

name (SSID) of your scanner.  
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2. Tap the PaperAir App ( ) on the screen to launch the 

Scan Application. The main window will be displayed and 

the application will automatically search a scanner in the 
same wireless LAN. If successful, [Start scan] will be 

displayed at the bottom as shown below. 

 
 

3. Check if the default settings meet your requirements. If 
not, change the scan settings to fit your specific scanning 

task. 
 

ITEM DESCRIPTION 

 

Resolution: Select your desired resolution. 

The higher resolution, the greater the image 
quality and disk space.  

Choice: *150, 200, 300 dpi 

 

Scan Size: Select your paper size or you may 

choose Auto to let the scanner detect your 
document size automatically.   

Choice: *Auto size, A4, LTR (Letter), LGL 

(Legal), 4x6, 5x7 

ATTENTION: 
If the scanner is not found, please 

check the followings: 
1. The scanner is not ready yet. Tap 

[More Settings] and then 
[Search scanner] to search the 

scanner again. 

2. Check if the mobile device and the 
scanner are in the same wireless 

LAN.  
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File Format: Select the file format for your 

image.  

Choice: *JPEG, PDF, TIFF 

Note: The JPEG file does not support the 

B&W image. 
 The TIFF file format supports only the 

B&W image. 

 

Select to scan the front side (simplex) or both 

the front side and the rear side (duplex) of 
your document.  

Choice: *Simplex, Duplex 
Note: The duplex mode is available to scan 

from the auto document feeder only. 

 

Color Mode: Select your desired image mode.  

Choice: *Color, B&W, Gray 

* Default settings 

 
4. Load a page to the auto document or place a page on the 

flat bed. 
 

5. Tap the [Start scan] button. (Choose your scanner if 
there is more than one scanner connected to the network).  

In a second, the scanner begins scanning the document 
and the thumbnail scanned image will be displayed.   

  

 
6.   Tap the thumbnail image to view the entire image. 
 

The 

Thumbnail 
Image 
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7. Maintenance 
 

 

7.1  Calibrating the scanner  

Calibrate only if the scanned image looks fuzzy, the color looks 

abnormal (e.g., darker than normal), after more than 8,000 
scans, or the scanner has been stored without use for a long 

time. The calibration process resets the Contact Image Sensor 
to resume its color and sharpness precision.  

1. Turn on the scanner. 

2. Start your TWAIN-compliant image editing software 
application such as Avision Capture Tool by choosing 

Start>Programs>Avision XXXX Scanner>Avision Capture 
Tool (XXXX indicates your scanner model). The Select 

Scanner Model dialog box will be displayed.  

3. Select your driver type and scanner model and click OK.  

The Avision Capture Tool dialog box will be displayed. 

4. Click the “Setup” button to prompt the TWAIN user 

interface. 

5. Click the “Settings” tab and then click the “Calibration” 
button.  An “Insert calibration sheet” dialog box appears. 

6. Hold the edges of the calibration sheet (included) and 

insert it with the text face up as shown. 
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7. Click the “OK” button on the “Insert calibration sheet” 

dialog box to start calibrating the scanner. 

8. Wait until the calibration has been finished. 

 

WARNING: 
 Do not interrupt the calibration sequence or try to shut off 

the device while it is calibrating.  
 Calibrate the scanner only when color of the scanned image 

looks abnormal.  
 Keep the calibration sheet from dust and debris.  Any dirt 

may make the calibration chart invalid or impact the 
calibration result. 

 Use only the included calibration sheet to calibrate the 
scanner. 
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7.2 Cleaning the scanner 

In order to maintain the scanned image quality and prevent 

dust accumulation, it is recommended that you clean the 
scanner (outer casing and feed rollers) approximately every 

200 scans, or if vertical lines or stripes appear on the scanned 
image. 

 

WARNING: Do not use any solvents or corrosive liquid 

(i.e., alcohol, kerosene, etc.) to clean any part of the 
scanner, otherwise the plastic material may be 

permanently damaged. 

 

1. Open the cover by holding the scanner with one thumb 

placing on the feeder and another thumb placing on the 

cover. Carefully and firmly press your thumb into the 
feeder and then raise the cover. This will cause the top of 

the scanner to release from the bottom of the scanner. 

 
 

2. Gently wipe the glass and feeding rollers on the scanner, 

and the CIS cover with the cleaning cloth. 
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Rollers 

Glass 
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8. Troubleshooting 
 

8.1 Clearing the Error Conditions 

If there is error during scanning, the LED light will be flashing 
in red color. Refer to the following table to clear the error 

conditions. 

 

The 

Number of 
Times the 

Red LED 
Blinks  

Description 

 

How to restore 

 

4 

(Continued) 
Paper jam 

Remove paper and try 
again. The Red LED light 

does not stop blinking 

unless the paper is 
removed. 

6 

(Continued) 
Cover open 

Close cover and then try 
again. The RED LED light 
does not stop blinking 

unless the cover has been 

closed. 

 

 
Warning: 

If the battery power is lower than 25%, the battery LED light 

will be blinking in red. Please recharge the battery to prevent 

possible incomplete scanned images or other operational 

problems. 
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8.2 Clearing a Paper Jam 

 

1. Open the cover by holding the scanner with one thumb 
placing on the feeder and another thumb placing on the 

cover. Carefully and firmly press your thumb into the 
feeder and then raise the cover. This will cause the top of 

the scanner to release from the bottom of the scanner. 

2. Remove the item. 

 

 

3. Close the cover and reinsert the item to rescan. 

 

 

 
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8.3 Questions and Answers 

 

Question: Why does not my scanner turn on? 

Answer:
  

Ensure the USB cable is securely 
connected to the scanner to the USB 

slot in your computer. 

 
 

Question: Why doesn’t my computer 

recognize my scanner when it’s 
connected via USB cable? 

Answer:

  

Make sure the cable connection is 

correct and secure. Restart the 
computer if necessary. 

 

Question: Should the scanner feel warm to 

the touch? 

Answer:  It is normal for the scanner to emit a 
small amount of heat after prolonged 

use. However, if there are strange 
odors coming from the scanner or the 

scanner feels a little bit hot to the 

touch, turn the scanner off 
immediately. 
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Question: Why there are strange lines on the 

scanned document? 

Answer:  Please check the following:  

1. Are there scratches on the original 

or is the original clean？ 

2. Remove any stains or dust from the 

original before scanning. 

3. Clean the rollers and glass with the 

included cleaning cloth.   

 

Question: Why does my scanned image 

always come out too dark? 

Answer:  1.  Please adjust the screen settings to 
sRGB. 

2.  Please adjust the brightness 
settings on the screen from 

application software. 

 

Question: When I choose optical resolution 
to be 600 dpi, the "auto crop" and 

"deskew" functions will be 
disabled. 

Answer:  Since to perform auto crop and deskew 

consumes great deal of system 
memory, it is suggested if you wish to 

perform "auto crop" and "deskew" 
functions, please choose your optical 

resolution to be smaller than 600 dpi 
to prevent a error message. 
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Question: What should I do if the status 
indicator blinks rapidly and no 

scan is possible? 

Answer:
  

Check the following: 

 Is there a jam in the feeder? Power 

the scanner off and then on again 
to continue the sheet feed. If the 

item is still jammed, open the 

cover and gently pull out the item.  

 Is the cover open? Make sure the 

cover is snapped firmly in place. 

 Did you insert the next original 

before the scanning process of the 
previous one was completed? Turn 

the scanner off and back on and try 
again. Make sure that you scan the 

next original only after the 

scanning process of the previous 
one has completed. 

 Does the length of the original 
exceed the maximum acceptable 

size?  
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Wi-Fi Mode: 

 

Question: Why can’t I see the Scanner’s Wi-Fi 
Network name (SSID) [SSID]? 

Answer:

  

Make sure you have slid the [Wi-Fi] switch 

to the [On] position and the Wi-Fi indicator 
light is lit on the LCD screen. If Wi-Fi Access 

Point is still in countdown mode, wait until 

the blue Wi-Fi indicator light turned solidly 
on. 

 

 

Question: Will the battery power get used up 

faster when Wi-Fi mode is on? 

Answer:
  

Yes. When Wi-Fi mode is on, the scanner 
does automatically turn off like it does 

normally. Therefore, it is recommended to 

turn off the Wi-Fi mode when images have 
been downloaded onto your computer. 

 

 

Question: Why can’t I connect to my email or 

other web related locations/programs 

after disconnecting from the scanner 
Wi-Fi network?  

Answer:

  

To resume your normal Wi-Fi connection, be 

sure to re-connect your computer, tablet or 
phone to your usual local Wi-Fi network 

when you are finished with your scanner 
connection. 
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8.4 Technical Service  

 

Before contact Avision, please prepare the following 

information: 
 

 Scanner serial & revision number (located on the bottom of 

the scanner); 
 

 
 

 
 

 Hardware configuration (e.g., your host CPU type, RAM size, 

free disk space, display card, interface card); 
 The name and version of your scanning software application;  

 The version of your scanner driver.  

 

 
Please call us at: 

 
Headquarter 
Avision Inc. 
No. 20, Creation Road I, Science-Based Industrial Park,  
Hsinchu 300, Taiwan, ROC 
TEL: +886 (3) 578-2388 
FAX: +886 (3) 577-7017 
E-MAIL:  service@avision.com.tw 

Web Site: http://www.avision.com.tw 

 
 

 

mailto:service@avision.com.tw
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US and Canada Area  
Avision Labs, Inc. 
6815 Mowry Ave., Newark CA 94560, USA 
TEL: +1 (510) 739-2369 
FAX: +1 (510) 739-6060 
E-MAIL:  support@avision-labs.com 

Web Site:  http://www.avision.com 
  

China Area  
Shanghai Technical Support Center 

7A, No.1010, Kaixuan Road, Shanghai 200052 P.R.C.  
TEL :+86-21-62816680 

FAX :+86-21-62818856 
E-MAIL :sales@avision.net.cn 

Web Site:http://www.avision.com.cn 
 

Europe Area  
Avision Europe GmbH  

Bischofstr. 101 D-47809 Krefeld Germany  

TEL: +49-2151-56981-40 
FAX: +49-2151-56981-42 

E-MAIL:  info@avision-europe.com 
Web Site:  http://www.avision.de 

 

Espaço Brasil  
Avision Brasil Ltda. 

Avenida Jabaquara, 2958 - Cj. 75 - Mirandópolis –  
CEP: 04046-500 - São Paulo, Brasil 

TEL: +55-11-2925-5025 
E-MAIL: suporte@avision.com.br 

Web Site: http://www.avision.com.br 

 

mailto:support@avision-labs.com
http://www.avision.com.cn/
http://www.avision.de/
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9.  Specifications 
 

 
 

All specifications are subject to change without notice. 
 

Model Number：  FF-2111B (simplex scanner) 

Image Technology:  Contact Image Sensor (CIS) 

Optical Resolution:  600 dpi 

Scanning Modes:  Black & White/Gray/Color  

Max. Paper Size:  8.5” x 14” (width x length) 

Min. Paper Size:  2.0” x 2.9” (width x length) 

Paper Weight:   52 ~ 105 g/m²   

ID Card Thickness:  Up to 0.76 mm  

Interface: USB Type-C port 

Wireless 802.11 b/g/n  

Power:  Battery (Li-ion18650, 
3.6V/2750mAh) 

Operating Temperature: 10ºC ~ 35ºC   

Humidity:    15%~85% RH 

Dimensions: (HxWxD) 294 x 67 x 47 mm 

Weight:   Approx. 480g 
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Wi-Fi Specifications: 

 

Model: CF-811AC 

Main Chipset RTL8811CU 

Host interface USB 2.0  

Frequency Range 2.4GHz&5.8GHz 

Wi-Fi Standard 

IEEE 802.11a 

IEEE 802.11b 

IEEE 802.11g 

IEEE 802.11n 

IEEE 802.11ac 

Transmit Speed 

11b：1/2/5.5/11Mbps 

11g：6/9/12/18/24/36/48/54Mbps 

11n：200Mbps 

11ac：433Mbps 

Security 

WPA-PSK/WPA2-PSK 

WPA/WPA2 

WEP 

Operating System 
Windows XP/Vista/7/8/8.1/10 (32/64 bit) 

macOS 10.6 ~10.15 
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